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pco.troubleshooting ‘  ~ Chapter 1

1 Introduction

This manual introduces you to the different options of troubleshooting with pco.software products.

Following these instructions will allow for optimal support from PCO and therefore benefit
the solution of your individual case.
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2 Logging with pco.camware 4

The pco.camware software is equipped with its own logging functions. The pco.logging tool is
not necessary here.

However, you may use the pco.logging tool for troubleshooting in case pco.camware crashes or
freezes during startup.

Follow these instructions to provide the PCO support with information about your individual case
in pco.camware.

2.1 Activate Log Files

As a first step, open pco.camware.

You can Enable Logging via the ? (help menu) in the menu bar.
Logging can be enabled while the camera is connected.

Q Camware - Camera 1 (pco.dimax HD)

File Camera Acquisition View Window | 7

Camera Overview

2 x
= 1
o= EE B -
- B Camera List

] Camera 1 (pco.dimax HD) Create Support File Clear Logfiles
+-Q, Preview Support Mail (=Support File) Explore Logfiles
Camera Setting

[E dimax Setting 1 About Disable Logging

& dimax Setting 2

9 Log files will be created during the next start of pco.camware or when a 'Scan Camera’ is
started.

@D  odile info!

Logfiles will be created during
next start of Camware or
when a 'Scan Camera'is started.

Save your image data before starting a rescan.
Now select Scan cameras.

©

Camera Overview

Q= 5B - EQ

v Scan cameras
=8 Q Start a camera scan.
= max HD)
- &, Preview
Lo - -
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pco.camware will ask whether you want to continue logging.
Confirm with YES.
Qamwaretl

Camware and driver logfiles are enabled! This cuts down performance!
Do you wish to continue logging?

Press 'NO to delete the log files and disable logging.
Press "YES' to continue with logging.

If you would like to create support files
press yes or SUPPORT.

Repeat the steps that produce the errors.

In case the camera is not recognized and pco.camware starts in demo mode, the logging already
documents possible communication problems.

2.2 Create Support File

After having reproduced the steps, create the support file and send it to PCO.
The following steps explain how this is done optimally.

e Select Create Support File via the ? (help menu) in the menu bar.

Q Camware - Camera 1 (pco.dimax HD)

File Camera Acquisition View Window |7

Camera Overview a X Contents
| q =l Lh 18 @ Q 1 Search for Help
=23 Camera List Logging »
.= [V] Camera 1 (pco.dimax HD) Create Support File [
+-Q Preview Support Mail (+Support File)
Camera Setting
[E) dimax Setting 1 About

o Camware Lodfile not found
If this window appears, log files are not found or have not been created yet. In this case, Scan
cameras again (e)

eamwarEA

Camware Lodfile not found!
Do you wish to continue without Camware Logfile?

If you press ‘NO ' the files will be created
during the next start or rescan of Camware!
In case ‘NO' please close and restart Camware or do a rescan.

Yes Cancel

e Click Yes to generate the support file that contains the log files and system information.
Send it to PCO support (support@pco.de)
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eCamware 4

Generate support file?
This will generate a file called CW Support zip,

which will be attached to the mail, if selected.

It will contain some logfiles and

additional info about your system:

PCO_Reg txt (Registry entries about driver)
Corflicts.nfo (Info file about the computers hardware).

Yes No
x

9 Support Mail
pco.camware can also create an email with the support file attached (standard email software

must be installed on your computer).

Q Camware - Camera 1 (pce.dimax HD)

File Camera Acquisition View Window |7

Camera Overview Contents

o X
Q X i ] @ Q 1 Search for Help
»

= z Camera List Logging
Create Support File

- (V] Camera 1 (pco.dimax HD)
. prevew

Camera Setting
[ dimax Setting 1 About

Please fill out the form with as much relevant information as possible to facilitate support:

Q = ¥ PCO, we've got i

|| Nachricht Einfigen Optionen Text formatieren u
= - - |
j M TA A
Einfigen F X U E=E= = i | Adre
Zwischenablage Basistext
An.. support@pco.de
=] Cc
Senden
Betreff: PCO, we've got a problem

Angefugt: ¢ CWSupport.zip (128 K8|

Dear PCO support,
We've got a problem. Here is the description:

Frxexe:*x**please fillin the following fields*****

First name:
Last name :
Company/Institution:

Telephone :
Operating system : <XP, W7, etc.; 32bit, 64bit?>

Camera type : <pco0.1600, pco.edge, etc.>
Serial number : <See sticker on your camera>
Interface : <FireWire, USB, GigE, etc.

Frrxxr==**please describe the error here****=****=*

Regards,

%

Alternatively, you can visit the PCO website and upload the support file via our support ticket.
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2.3 Demo Mode

If pco.camware cannot detect any connected camera, it will start in demo mode.
It is also possible to activate log files in demo mode.

Demo Mode Setup ? X

Error on startup! No camera detected or no board

found! Starting without camera functions.

Please select color and resolution for demo mode.
Resolution

2560=2160 pco.edae 5.5 ~ | 1Bbit v
%[2560  |v[2180 | [JDouble Shutter

Color Alignment

@® b/w O color O lower (@ upper
PRESS 'Rescan'n log.' TO =t
ENABLE LOGGING. This

enables logging and rescans Need help?
cameras. =y

If you only like to contact pco, please press OK and
select '?/4bout’ and 'Support'.
Cancel | IHescan'n Iog.l I 0K I

Demo mode will ask whether you want to Rescan’n log. After pressing this button, pco.camware
will start a rescan and activate log files.

pco.camware will ask if you want to continue logging. Select YES.

Camware 4

Camware and driver logfiles are enabled! This cuts down perfformance!
Do you wish to continue logging?

Press 'NO to delete the log files and disable logging.

Press YES to continue with logging.

If you would like to create support files
press yes or SUPPORT.

Now select SUPPORT to create a support file.

Press SUPPORT to create the =5
support file and support mail.
HE S Need help?
If you only like to contact pco, please press OK and
select '?/About’ and 'Support’,

Cancel suproRT || [ ok ]

pco.camware can also create an email with the support file attached (standard email software
must be installed on your computer).

For this option, see step 0 of chapter 2.2.
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3 Logging with pco.camware 3

3.1 Activate Log Files

o Open pco.camware, select the File tab, and then select Options.

q CamWare V3.17

Camera Acquisition View Window 2

Open Raw File CTRL+I
Open Raw Recorder Sequence CTRL+R
f Save Raw File CTRL+E
Save Raw Recorder Sequence CTRL+S
Export File (not reloadable!) CTRL+T

Export Recorder Sequence (not reloadable!) CTRL+O

Print Setup

Print Preview

==, Print... CTRL+P

Options L‘\’
Load Lookup Table

9 You have to enable the Application Logfile and Diver Lodfile in the Misc menu.

thions ? X

File settings

. ; Infotext Scroll Mode
View settings
Toolbar [[] Show &t Startup Synchronous
Embedded Image Info
View Image Info Select Info
Multi Win Picture Order
amera order mage time stamp
[O]= der Ol {
Logfile
Application Logfile Clear Logfiles
Driver Logfile I} Explore Logfiles
Please restart Camware to create the logfiles!
Cancel
pco.

pco.troubleshooting user manual 1.0.1
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e Select the Camera tab and click Rescan. pco.camware will rescan for connected cameras and
log files can consequently be enabled.

Q CamWare V3.17
File | Acquisition  View

| -
- ‘“ Camera Control

Load Camera Settings

@ 0

Save Camera Settings

I
3

View Settings

Create Hot Pixel List
Hotpixel Correction
Auto Exposure

Close

Rescan N ‘

o pco.camware will ask whether you want to enable log files. Select YES.

CamWare

Camware logfile is enabled! This cuts down performance!
Do you wish to continue logging?

Press 'MOD' to delete the log files and disable logging.
Press 'SUPPORT' to create the support file.

Press "YES' to continue with logging.

If you would like to create support files

press yes or SUPPORT.

SUPPORT YES

e Repeat the steps that produce the errors.
In case the camera is not recognized and pco.camware starts in demo mode, the logging already
documents possible communication problems.
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3.2 Create Support File

After having reproduced the workflow, please create the support file package (CWsupport.zip)
and send it to PCO.

o Select the ? (Help) menu and then select About.

Q CamWare V3.17

File Camera Acquisition MiewD

L[EI'J B IE ‘ﬂ i Contents

Search for Help on

an g @] About |\

o The About CamWare window will appear, indicating three different support options:

Support (Mail only): opens a mail template that can be filled and sent to PCO support.
Support (Mail with support files): Same as above, but with the CWsupport.zip attached.
Support (Support files only): Generates the CWsupport.zip

About CamWare (64bit) Ver.: 3.17, Build Nr. 0564 X
camware

Support (Mail only): support@pco.de
Support (Mail with support files): )
Support (Support files only):
Visit our homepage:

support@pco.de

http: /v, pe:

Warning: This program is protected by copyright law and intemational treaties.
Unauthorized reproduction of this program, or any portion of it, may result in
severe civil and criminal penalties, and will be prosecuted to the maximum
extend possible under law.

Copyright [c) 2015 PCO AG: The licensee is granted a non-exclusive and
non-transferrable right to install the software and use it as an application.

pco.camware will ask whether you want to Generate support file? (CWsupport.zip).
Also generated are the PCO_Reg.txt with entries about drives, and Conflicts.nfo, a file that

contains information about the computer hardware.
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camware K

CamWare

" Generate support file?
This will generate a file called C\w/Support.zip,
which will be attached to the mail, if selected.

Sup| It will contain some logfiles and
additional info about your system:

S

Szp PCO_Req.tst (Registry entries about driver)

VisI; Conflicts.nfo (Info file about the computers hardware).

W, Es.
- | No | | Yes %J Cancel s

Unal

sev =z

—~
extend possible under law.

Copyright [c) 2015 PCO AG: The licensee is granted a non-exclusive and
non-transferrable right to install the software and use it as an application.

9 Please fill out the form with as much relevant information as possible to facilitate support:

Q = ¥ PCO, we've got i

Nachricht Einfagen Optionen Text formatieren Ut
o { _ -~ 1
J M TA A
Einfugen F £ U ay = = = | iE i= | Adre
Zwischenablage Basistext
An... support@pco.de
| meif] o
Senden
Betreff: PCO, we've got a problem
Angefugt: £ CWSupport.zip (128 KBJ

Dear PCO support,
We've got a problem. Here is the description:

#xxExsrxx+please fillin the following fields*****
First name:

Last name :

Company/Institution:

Telephone :

Operating system : <XP, W7, etc.; 32bit, 64bit?>
Camera type : <pco0.1600, pco.edge, etc.>

Serial number : <See sticker on your camera>
Interface : <FireWire, USB, GigE, etc.

*rxxxe==**please describe the error here****==***=*

Regards,

%

Alternatively, you can visit the PCO website and upload the support file via our support ticket.
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3.3 Demo Mode

If pco.camware cannot detect any connected camera, it will start in demo mode.

It is also
possible to activate log files in demo mode.

In pco.camware 3, this tool tip describes the steps for creating log files and the support file.

Demo Mode Setup ? X

Error on startup! No camera detected or no board
found! Starting without camera functions.
Please select color and resolution for demo mode.

Resolution

2560x2160 pco.edge 5.5 ~ | 16bit v
%|2560 |v 2160 | [JDouble Shutter
Color Alignment

®bsw O color (O lower (@) upper

PRESS 'Rescan'nlog.' TO =

ENABLE LOGGING. This '
enables logging and rescans Need help?

If you only like to contact pco, please press 0K and

select "?/About’ and 'Support’
ancel Rescan'n Iog.l I oK

Demo mode will ask whether you want to Rescan’n log. After pressing this button, pco.camware
will start a rescan and activate log files.

Three easy steps to get help: )
PRESS 'Restart'n log.' TO L ]

ENABLE LOGGING. This Press SUPPORT to open the
enables logaing and restarts 'about box' for contacting peo.
Camiw/are.

Upport@pco.de
support@pco.de
Create support files only
http:/#www.pco.de

Support (Mail only):

Support (Mail with support files):
Support (Support files only):
Visit our homepage:

pco.imagng

pco.camware will ask if you want to continue logging. Select YES.

Camware 4

Camware and driver lodfiles are enabled! This cuts down performance!
Do you wish to continue logging?

Press 'NO to delete the log files and disable logging

Press "YES to continue with logging.

If you would like to create support files
press yes or SUPPORT.

Now select SUPPORT to create a support file.
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Press SUPPORT to create the

support file and support mail,
S M Need help?

pco.
If you only like to contact pco, please press OK and

select "?/About’ and 'Support’,
Cancel suproRT || [ ok ]

pco.camware can also create an email with the support file attached (standard email software
must be installed on your computer).

About CamWare (64bit) Ver.: 3.17, Build Nr. 0564 X
camware
.
Support (Mail only): support@pco.de

Support (Mail with support files):
Support (Support files only):
Visit our homepage:

port@pco.de

Warning: This program is protected by copyright law and intemational treaties.
Unauthorized reproduction of this program, or any portion of it, may result in
severe civil and criminal penalties, and will be prosecuted to the maximum
extend possible under law.

Copyright (c) 2015 PCO AG; The licensee is granted a non-exclusive and
non-transferrable right ta install the software and use it as an application.

Please fill out the form with as much relevant information as possible to facilitate support:

EXIR™| ¥ PCO, we've got i
Nachricht Einfigen Optionen Text formatieren Ut
- ) . == {
J T TA A = — 7
Einflgen F ¥ U |2 \ = = = | i£ i | Adne
Zwischenablage Basistext
An... support@pco.de
=1 ce..
Senden
Betreff: PCO, we've got a problem
SAUEiBgE ¢ CWSupport.zip (128 KBJ

Dear PCO support,
We've got a problem. Here is the description:

srswsszzs=please fillin the following fields****=
First name:

Last name :

Company/Institution:

Telephone :

Mnnrating cuctam < 2VN AT Ate - 29kt GAR#I
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3.4 Potential Error

Using pco.camware 3 with Windows might cause a common error:
If the creation of the CWsupport.zip takes very long, the Windows log files must be deleted in the
event viewer.

0 Clear the Windows log files

Open the event viewer: Win + R — eventvwr — OK

o Run X

= Type the name of a program, folder, document, or Internet
— resource, and Windows will open it for you.

Open: | BT v
Cancel Browse...

e Clear all Windows logs and Application Logs
CWSupport.zip can then be generated much quicker.

& Event Viewer

File Action View Help
| zwE HE

{2] Event Viewer (Local) Application Number of events: 20,356

v [ Custom Views

7 Administrative Events ||| L€ve! Date and Time
v [ Windows Logs (@ Information 11/29/2016 11:20:46 AM
& Applic T 11/29/2016 11:20:46 AM
q S::m Open Saved Log...
] setup Create Custom View...
] Syster Import Custom View... 11/29/2016 11:20:45 AM
E] Forwa A 11/29/2016 11:20:45 AM
v (£ Applicatic : N 11/29/2016 11:20:45 AM
{&] Hardw Filter Current Log...
=] Intern Properties
- rror Reporting
ElKeyM  ging..
= ::fzrz Save Al Events As...
15 icra
& Windc Attach a Task To this Log... —
24 Subscripti View > (AgentDownloadFailurel
rfiigbar
Refresh
Help >
P2: 80244018
P3: 10586
P4: 679
P5: Windows.Desktop
P6: 2
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4 pco.logging: Logging with Third Party
Applications

In this chapter, you will learn how to provide the PCO support with information via the pco.logging
tool.

The aim of this tool is to simplify the control and creation of log files for the PCO software tools
that are integrated into or used by custom application software.

If you are only using pco.camware to control PCO cameras, please use the in-built logging
functionality (see chapter 2).

In case pco.camware crashes or freezes during startup, you can use pco.logging instead.

The application has been designed to be simple and as small as possible so that it can be kept
open during your entire testing/development process. You will always have an overview of the
activated log files. This is especially relevant as logging affects the performance.

For any questions or comments, please feel free to contact us at any time.

4.1 Components

The pco.logging ZIP file contains the following components:

pco.logging.exe The actual application. It is a standalone with no further dependencies.

license.txt Contains the licence information. By using the application, you agree on these licence
terms.

releaseNotes.txt Contains the version information.

readme.txt A readme file that also contains the information of this chapter.

4.2 Procedure

First, download the latest software via the PCO website.

LabView If you use pco.logging with LabVIEW, close all windows and processes before and after you start
the logging process.
Otherwise, the logging process cannot be completed successfully.

Python Restart the Python kernel whenever you activate or decativate pco.logging, otherwise the log files
are not considered.

pco.troubleshooting user manual 1.0.1 pco 16
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The pco.logging interface contains the following components:

% pco.legging ? X

Fnable Logging: Clear Log Files
-~ pco.sdk logging
D pco.recorder logging Explore Log Files
D pco.matlab adaptor logging
=-[] peo.interface logging Log Level
-] FireWire Standard e
{1 Camera Link
[ Camera Link HS
[1uUsB3
Create Support File
| Support Mail (+Support File) |

o shows all possible log files and if they are currently enabled.
o With this you can dynamically activate or deactivate the log files.
e Please make sure to always do this before you start the application that should be logged.
e The tool automatically checks the logging every few seconds and updates the tree.

o It will also notice if log files are activated or deactivated by other applications.

% pco.legging ? X

Enable Logging: Clear Log Files
[ pco.sdk logging
L pco recorder logging Explore Log Files
D pco.matlab adaptor logging
5[] pco.interface logging Log Level
I:l FireWire Standard i

I:| Camera Link

Create Support File

| Support Mail (+Support File) |

e shows two buttons and a drop down menu (on the top right) to interact with the log files.
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e The Clear Log Files button deletes the content of all log files to make sure you only log the
relevant session.

e The Explore Log Files button opens the folder where the log files are placed.

e The Log Level drop down controls the level of detail in the log files.
In most applications/errors, the standard log level is sufficient. As the levels high or full
create a great amount of data (and cut down your PC performance), it is recommended to
only use this level when PCO staff advises you to do so.

% pce.logging 7 x

Enable Logging:

Clear Log Files
-~ pco.sdk logging
-0 pco.recorder logging Explore Log Files
I:l pco.matlab adaptor logging
: Log Level

=R pco.interface logging
- EireWire Standard ~

----- {1 Camera Link

Create Support File

| Support Mail (+Support File) |

e shows two buttons (on the bottom) to create a PCO support file equivalent to the file that can
be created in pco.camware.

e The Create Support File button will create and zip the file.

e The Support Mail (+Support File) button will do the same and additionally generates an
e-mail to PCO with the file attached.

pco.troubleshooting user manual 1.0.1 pco 8
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5 Enable Logging Manually

Applicable for pco.camware or third party software.

Share View

A C \ T New item ~ ) Ope Select all
L X v -

7] Easy access . Select none
Delete New Properties

folder ©History 7 Invert selection

=

> ThisPC > Local Disk (C:) > ProgramData > pco I

Name

-] PCO_CDIg.txt
9 PCO_Conv.txt
] SC2_Camitt
] sc2_Usb.bxt

If pco.camware is started (or SDK is addressed during a third party software session) with the
default configuration, the folder pco is always automatically created within C:\ProgramData (this
folder is hidden and must be unhidden manually).

Within this folder, several .txt files are created.

Each .txt file contains a short description on how to manually enable the logging.

Logging consumes time and should not be enabled permanently. SC2_Cam.log will be overwritten
at the start of a new session.

If you want to have more than one session logged, rename this file to SC2_Cam_a.log.

If both files exist, SC2_Cam_a.log will be used.

To enable logging for the interface, you have to create the log file and a parameter file. Each
interface has its own log file and thus its own filename. To enable logging for the corresponding
interface, please create the appropriate log file.

Firewire sc2_1394.log
GigE sc2_gige.log
GigE2 sc2_gige2.log
Camera Link Matrox sc2_cl_mtx.log

Camera Link National Instruments | sc2_cl_nat.log

Cameralink Silicon Software Me4 | sc2_cl_me4.log

USB 2.0 sc2_usb.log
USB 3.0 sc2_usb3.log
Camera Link HS sc2_clhs.log

Parameter ini files ‘

Firewire sc2_fw_param.ini
GigE sc2_gige_param.ini
Continued on next page
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Continued from previous page

Parameter ini files ‘ ‘

All Camera Link interfaces | sc2_cl_param.ini
USB 2.0 sc2_usb_param.ini
USB 3.0 sc2_usb3_param.ini
Camera Link HS sc2_clhs_param.ini

Note This entry must be added to the parameter file:

[LOGGING]
LOGGING=0x0000FFFF
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pco europe
+49 9441 2005 50
info@pco.de
pco.de

pco america
+1 866 678 4566
info@pco-tech.com
pco-tech.com

for  application  stories
please visit our website

pco asia

+65 6549 7054
info@pco-imaging.com
pco-imaging.com

pco china

+86 512 67634643
info@pco.cn
pco.cn
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